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Welcome to ConceptDraw DIAGRAM 18 for macOS

Computer Systems Odessa Corporation introduces you ConceptDraw DIAGRAM - a world-class
diagramming software that lets you display, communicate, and present dynamically on Mac and PC
platforms.. ConceptDraw DIAGRAM is powerful enough to draw everything from basic flowcharts to
complex engineering schematics.
World-Class Diagramming
Benefits
ConceptDraw Maintenance Assurance
Technical Support

 
World-Class Diagramming
ConceptDraw DIAGRAM is a diagramming tool that lets you easily create diagrams in minutes to
support any business communication process. You can create simple or complex drawings to
communicate status or condition to your audience.
ConceptDraw DIAGRAM creates drawings, diagrams and charts with great visual appeal. It is simple to
express ideas to share with others that quickly convey what you are thinking when using ConceptDraw
DIAGRAM. ConceptDraw DIAGRAM is a spectacular, easy-to-use tool for preparing presentations and
business documentation, describing structures and processes, making schematic diagrams, and
drawing technical sketches.
 ConceptDraw DIAGRAM is powerful enough to be the standard-bearer business graphic tool for
organizations of any size, producing rich visual documents that convey meaning and support company’s
internal and external communication needs. Graphic company communications include dashboards
displaying key performance indicators and depiction of processes based on company data. From simple
to complex, ConceptDraw DIAGRAM fills every niche.

 
Your Benefits
Simplifies and enhances presentation generation with flexible slide construction, automated processes,
and Live Object technology for displaying external data. Contains an extensive library of over 20,000
ready-to-use objects, with hundreds of templates and examples to get you started quickly.
ConceptDraw DIAGRAM also supports dynamic presentations that contain live content and can be
edited on the fly to reflect input from collaboration or feedback. Presentations can be exported to
numerous graphical formats or emailed as a slide show. ConceptDraw DIAGRAM presentations can be
displayed in full-screen, automated playback mode, or using dual monitors — display on one, edit on the
other — for team collaboration.

 
ConceptDraw Maintenance Assurance 
We have developed an innovative maintenance program that makes sure you stay up to date. At the time
of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance 

 
Technical Support
We offer unlimited free technical support to our  users.
To send us a problem report or feature request, submit the ticket form in the Help Desk section on our
Web site.
Replies are normally sent within one business day. We are always happy to answer your questions and
hear your feedback.

https://www.conceptdraw.com/helpdesk/how-to-upgrade-from-previous-versions
https://helpdesk.conceptdraw.com/ticket.php
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Toolbars

 

 
 
 

The ConceptDraw DIAGRAM tools are grouped on toolbars based on the type of task you perform with
them:

Main Toolbar
The ConceptDraw DIAGRAM  Main  Toolbar  provides quick access to functions that are commonly
performed within the application.
 
Tools Toolbar
The Tools Toolbar contains all of the drawing tools you need to draw and edit your custom drawings. 
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Main Toolbar  

Main Toolbar

 
This toolbar contains all buttons for comfortable work with ConceptDraw.
The default set of buttons:

   

Solutions Open the Solutions panel.

Pages Open the Pages panel.

Layers Open the Layers panel.

My ConceptDraw Open the My ConceptDraw panel.

Library Open the Library panel.

Connector ConceptDraw DIAGRAM makes it easy to connect objects in your drawing.
You can use one of the the Connector tools.To connect elements using this
tool, drag the connector from one connect point to another. You can use
Format panel to customize the selected Smart connector or change it to a
different type of connector.

Rapid Draw Activate Rapid Draw mode. 

Chain Activate the Chain Connection Mode.
Consistently connect  selected objects with  Connectors.
New object will  be automatically connected to selected one.
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Main Toolbar  

Tree Activate the Tree Connection Mode.
Connect  selected objects with  Connectors in a tree structure.
New object will  be automatically connected to selected one.

Operations Click the drop-down button to access the full list of available operations with
objects containing in the Basic Shapes library. 

Text Orientation You can manage the orientation of the text in the selected object by
choosing one of the options: horizontal, rotate 90 degrees clockwise or
counterclockwise.

Snap Activate snapping an object to neighboring objects.

Grid On/Off Grid.

LaTex Convert the selected  text to LaTex code

Side
Panels

Format Open the Format group of panels, which includes: Arrange $ Size, Format,
and Text side panels.

Hypernote Open the Hypernote side panel.

Info Open the Info group of panels, which includes: Info, Custom Properties, and
Advanced side panels.

Present Open the Present side panel.

You can add some extra buttons to the toolbar or to the default set of buttons using the Customize
Toolbar... dialog.
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Main Toolbar Rapid Draw

Rapid Draw

Rapid Draw functionality enables you creating diagram with just the keyboard. Use the combination
Ctrl+Arrow keys to select the direction. 
Then, continue to press the same keys until the appropriate object is selected and press Enter.

Rapid Draw allows you to create professional diagrams in a few simple steps.
1. Open the desired library.
2. Add the needed object to the document. This will be the starting point for your diagram.
3. Activate Rapid Draw mode using one of the Rapid Draw buttons.
4. Click one of the small blue arrows that appear to add the next object in the proper direction. The
object appears and the connection is automatic.
5. Deselect objects in the current Rapid Draw object chain to disable quick drawing mode.

Use the Rapid Draw mode that is most suitable for your objectives.

 
Rapid Draw mode is better to use when building a diagram consisting of  identical objects. You can
create your diagram with just the keyboard. 
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Main Toolbar Rapid Draw

Rapid Draw Library mode helps you to quickly build a diagram from the active library.

Select Rapid Draw Page mode to use only objects already added to the document page.
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Main Toolbar Rapid Draw

Some ConceptDraw DIAGRAM libraries have built-in Rapid Draw features for their objects
For example, the Flowchart Rapid Draw library. 

Engage Rapid Draw object from a library and then hover your mouse over an object at a drawing page.
Directional arrows surround the selected object. Select the appropriate direction for your diagram. Then,
select the object you want to add. You can create your diagram with just the keyboard. Use the
combination Ctrl+Arrow keys to select the direction. Then, continue to press the same keys until the
appropriate object is selected and press Enter.
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Main Toolbar Operations

Operations

Operations
The commands from this menu allow you to combine several shapes in one or separate shapes to
individual segments.

Union: Create an object from the perimeter of multiple overlapping objects.

     Before     After

Combine: Combine the selected objects into a solid multi-component object.

    Before      After 
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Main Toolbar Operations

Fragment: Cut out the overlapping portions of multiple shapes based on intersecting lines with  primary
shape in multiple selection.

   Before     After

Difference: Divide multiple objects into smaller parts based on intersecting lines or overlap and cut out
the overlapping portions.

 Before     After

Subtract: Create an object by subtracting from the  primary selected object the areas where subsequent
selected objects overlap. 

 Before     After
Extract: Create an object by subtracting from subsequent selected objects the areas where the primary
selected object overlap.

 Before      After
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Main Toolbar Operations

Intersect: Create shapes from the areas where multiple shapes overlap with the primary selected shape.

 Before    After

Separate: Separate combined objects.
Section: Create multiple shapes by cutting the selected shapes along the cut line created with the Line
tool. The Line should be a primary object in the selection.

Before   After

Join: Join selected objects into a single shape, if they are unclosed figures. For example lines, arcs
e.t.c. If they are closed figures such as rectangle or circle, this command will act the same as the
Combine command. 

             Before                       After 
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Main Toolbar Convert to LaTex

Convert to LaTex

If you want to enter mathematical notation, you can use an embedded LaTex plugin. 
LaTeX is a markup language and typesetting system designed for typesetting scientific texts. 

1. Select an object.
2. Insert a LaTeX snippet. 
3. Exit the text edit mode and activate the selection mode.
4. Click "Convert to LaTex".

You can insert an inline formula by typing the equation inside $..$ For example:

LaTex Snippet

Result
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Main Toolbar Convert to LaTex

To obtain a numbered formula you need to use the {equation} environment. For example:

LaTex Snippet

Resalt
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Main Toolbar Convert to LaTex

A matrix can be created using the matrix environment. For example:

LaTex Snippet

Result

Detailed information about LaTeX syntax can be found here:
 https://en.wikibooks.org/wiki/LaTeX/Mathematics

https://en.wikibooks.org/wiki/LaTeX/Mathematics
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Tools Toolbar  

Tools Toolbar

This toolbar contains the main drawing tools.

Selection tool
Select, move and, resize object. Selection Tool  is active by default. To select a single shape, point
the Selection tool to the object. When the pointer turns into a four-headed arrow, click the object.  
Green handles and the shape functional buttons appear on the shape when you select it providing
you with quick access to some operations that can be carried out with the selected object. The
yellow control handle is intended for the object's text shifting.  Some complex objects are supplied
with additional control handles used for changing the positions of parts of objects relative to each
other.

When you want to change a number of objects, you can select multiple objects to work with them
all at once. 
Point  Selection tool to the object. Place the pointer above and to the left of the objects you want to
select, and then drag to create a selection area around the objects. After you select the shapes,
you'll see green selection handles around the primary object. Other objects will have blue selection
handles.
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Tools Toolbar  

Text Selection Tool

Activate the Text Selection tool when you need to edit a text in ConceptDraw DIAGRAM document.
Click the mouse once to activate the edit mode. Double-click to select the entire word.

 Drawing Tools
Rectangle tool
Click in the upper left corner of where you want to place your rectangle and drag to the lower
right corner to define the rectangle.

To draw a square, hold the Shift key down while dragging down and across the screen.Activates
the Rectangle tool mode and lets you draw rectangle boxes, and also move and resize
shapes.
Ellipse tool
Click in the upper left corner of where you want to place your ellipse and drag to the lower right
corner to define the ellipse.
To draw a circle, hold the Shift key down while dragging down and across the screen.
Text Box Tool

Text Box  (Ctrl+2)  - Insert, remove and resize text. Double-Click  to start text edits

Title Text Box 
 Add pre-formatted  titles and headings.

Callout 
Click in the upper left corner of where you want to place your callout and drag to the lower right
corner to define its shape.
To draw a square, hold the Shift key down while dragging down and across the screen. Use
Action Menu to hide all callouts
To show all callouts, go to the Layers panel and switch on the "Comments" layer visibility.
Direct Connector tool
Draw Direct Connector between objects

Click on the object you want to connect and drag to other object to connect it.

Line Tool
Draw line.

Arc Connector tool
Draw Arc Connector between objects

Click on the object you want to connect and drag to other object to connect it.
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Tools Toolbar  

Pen Tool

Draw a  freeform line.

Edit Vertex

Activate this tool to  see the vertices of the object.  You can change the form of object  by
dragging the vertex. Drag the vertex where you want it and then release the mouse button.
Vertex Tool
Insert Vertex to the selected segment.

Cut Edge
Cut the object's geometry.  Lets you customize the shape by cutting the its edges. 

Connection Point tool
Activate the Connection Point tool  to insert and manipulate connection points.

Activates the Zoom box mode.
Activates the Scroll Hand mode.
Clone Tool
If there is a shape selected in the document or in the library, you can insert this shape into the
document by a single click on the page.
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Tools Toolbar  

  Activates the Eyedropper tool.

 Activates the Format painter tool.

You can apply the style of the particular shape to other shapes in the drawing.
To get started:
1. Select shape with the style you want to copy
2. Copy it to clipboard
3. Click the Format Painter icon
4. Select the shape(s) you want to apply the style
If you need to apply the copied style to multiple objects, just hold the Shift key down.

Activates the Crop tool.
You can crop the inserted image to remove any unwanted areas.

Zoom Slider - Move the slider to zoom in or zoom out a document page.
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Menus

ConceptDraw has the Main Menu and a number of Context Menus, which depend on what the user
is doing at the moment, and in which window the user is working - in the document window, or
ConceptDraw Basic editor window, etc. The main menu also looks different in different views. 
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Main Menu  

Main Menu

The Main Menu bar at the top of the screen displays the top-level menus in ConceptDraw DIAGRAM.
These menus include standard menus provided by the macOS system, as well as custom menus the
application defines.

When working with the ConceptDraw DIAGRAM document window, the main menu bar looks as follows:

 
ConceptDraw DIAGRAM menu
File menu
Edit menu
View menu
Insert menu
Text menu
Shape menu
Tools menu
Inspectors
Window menu
Help menu
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Main Menu ConceptDraw Menu

ConceptDraw Menu

ConceptDraw  DIAGRAM menu contains commands of the application

About ConceptDraw DIAGRAM
Opens the About window, where you can see the information about the application version and
developers.

Settings...
Opens the Settings dialog. It allows you to change default application settings that will be applied to all
new documents created in ConceptDraw DIAGRAM. 

Hide ConceptDraw DIAGRAM
Hides the ConceptDraw window to the dock.

Hide Others
Hides all other windows except the active ConceptDraw window.

Show All
Opens all hidden windows from the dock.

Quit ConceptDraw
Quits the application. Changes to Quit and Keep Windows when the Option key is pressed.
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Main Menu File Menu

File Menu

The File menu contains commands for working with files - opening, closing and saving files.

Welcome
Opens CDDZ  document containing short demo animations on how to get started with  ConceptDraw
DIAGRAM.

New
Creates a new ConceptDraw document.

New With Template - Creates a new ConceptDraw DIAGRAM document with the page size properties
selected.

Template Setup
Opens the Template Setup  dialog which will help you start using ConceptDraw DIAGRAM.

Open
Opens a file.

Open Recent...
Lets you open a file from the list of recently opened ConceptDraw DIAGRAM documents.
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Main Menu File Menu

Close Window
Close the currently open application window

Close All
Closes all opened documents.

Save
Saves the document in the selected format.

Save As...
Saves the document  in the selected format under a new name.

Duplicate
Create a copy of the active document instantly, in the same location as the original file.

Rename...
Rename the active document.

Move To...
Move the active document to another location.

Revert to
Lets you immediately revert ConceptDraw DIAGRAM document back to the saved versions of that file.

Share
Share the active document using the options listed in macOs embedded Share menu.

Import
Opens a file in a format, different than ConceptDraw DIAGRAM.

Import -> Graphic File
Import data from graphic formats (emf, wmf, pct, pict, bmp, dib, gif, jpeg, jpg, png, tif, tiff).

Import -> Microsoft Visio  Drawings (VSD, VSDX, VDX)
Import  data from  Microsoft Visio 2003-2010 and 2013-1016 Drawings

Import -> Microsoft Visio Stencils (VSS, VSSX)
Import  data from Microsoft Visio 2003-2010 and 2013-1016 Stencils 

Import -> Microsoft PowerPoint  (PPTX)
Import  data from Microsoft PowerPoint 2007 and newer (.pptx) Documents

Import -> PDF as image
Import a PDF document as a set of high-resolution images, ensuring better image quality. 

Import > SVG 
Import a Scalable Vector Graphics format
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Main Menu File Menu

Export
Exports the current document to a format, different than ConceptDraw.

Export -> Flash...

Saves the document in  Macromedia Flash format.

Export -> Graphic File...
Saves the document in a graphic file.
 
Export -> HTML...
Saves the document as HTML files. You can choose the export parameters using HTML Export Wizard.

Export -> Microsoft PowerPoint (PPTX)
Saves the document  as a Microsoft Office PowerPoint Document (pptx, .ppt)
 
 
Export -> Microsoft Visio 2010 (VDX) .
Saves the document in Microsoft Visio 2003-2010 Drawing (.vdx)
 
Export -> Microsoft Visio 2013 (VSDX) .
Saves the document in Microsoft Visio Drawing (.vsdx)
 
Export -> PDF .
Saves the document in  Adobe Acrobat PDF format

Export -> SVG...
Saves the document in the SVG format.
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Main Menu File Menu

 
Library
The menu for working with libraries.

Library -> New...
Creates a new library.

Library -> Open...
Opens a library.

Library -> Close
Closes the active library.

Library -> Close All
Closes all open libraries.

Library -> Save
Saves the active library.

Library -> Save as...
Saves the active library under a new name.

Library -> Properties...
Changes the properties of the library in the Library Properties dialog.

Document Properties...
Contains options allowing you to configure the parameters of the particular document in the Document
Properties dialog.

Page Setup...
Allows to set the printer page parameters in the Page Setup dialog.

Print...
Opens the Print dialog.
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Main Menu Edit Menu

Edit Menu

This menu contains various commands for editing documents.

Undo
Cancels the most recent action. The name of the last action is displayed in the menu item.
 
Redo
Cancels the last Undo operation. The name of the last action is displayed in the menu item.
For more information see Shapes - Operations on Shapes - Undo and Redo.

Cut
Cuts selected text or shapes and copies them onto the Clipboard.

Copy
Copies selected shapes or text onto the Clipboard.

Copy As
Copies selected shapes or text  in any of the following formats:
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Main Menu Edit Menu

Paste
Inserts the contents of the Clipboard into the document.
 
Paste as
Inserts the contents of the Clipboard into the document  in any of the following formats:

Delete
Deletes selected shapes.

Delete Page
Deletes selected pages.

Duplicate
Creates a copy of the selected shape.

Clone Stamp
Activates the Clone  tool. Lets you create a resized copies of the selected object.

Select All
Selects all shapes in the document.

Select Connected
Selects all shapes, connected to the selected shape with connectors.
If the shapes, connected to the selected shape also have shapes, connected to them, these shapes are
selected as well.

Put into Library
Adds selected shape(s) into the active library.
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Main Menu Edit Menu

Library Object
The menu for working with shapes in the active library. This menu is enabled when there is an open
library.

Library Object -> Cut
Cuts the selected library shape and copies it onto the Clipboard.

Library Object -> Copy
Copies the library shape onto the Clipboard.

Library Object -> Paste
Pastes the shape from the Clipboard into the library.

Library Object -> Remove
Removes a shape from the library.

Library Object -> Replace
Replaces the selected shape in the library with the selected shape in the document without changing the icon.

Library Object -> Change Icon
Changes the icon of a library shape.

Library Object -> Properties
Edits properties of the library shape.

Change Shape
Change the selected objects using one of the listed options.

Find
Opens the Find&Replace Text dialog to search / replace text in the shapes in the document.
 

Check Spelling
Opens the Spelling dialog. Allows to check spelling during typing
 
Start Dictation
With Apple's Dictation feature, you can use your voice instead of typing text.

Emoji & Symbols
Allows adding special characters in the text.
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Main Menu View Menu

View Menu

This menu controls how the document is displayed, whether to show toolbars, floating dialogs and more.

Show All Tabs
The embedded macOS functionality. A fast way to open a new window in an app as well as navigate
between opened windows.

Zoom In
Increases magnification.

Zoom Out
Decreases magnification.

Zoom
Lets you choose various zoom settings.

Zoom -> Actual Size
Displays the document at its actual size (100 % zoom).

Zoom -> Whole Page
Sets the zoom level so that the entire page fits in the window.

Zoom -> To Page Width
Sets the zoom level so that the page width fits in the document window.

Zoom -> Fit To All Objects

Sets the zoom level so that the all the shapes on the page fit in the document window.
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Main Menu View Menu

Start Presentation
Show slide presentation from current document. Slides will be created from document's pages.
Click at  bottom of screen to access the presentation control panel.

Start Presentation from Current Page
Start slide show from the current page.

Rulers
Shows/hides the rulers.

Grid
Shows/hides the grid.

Guides
Show/Hide Guidelines.

Page Breaks
Lets you choose to show/hide the page breaks for the documents. (Page breaks are gray lines which
mark the non-printable areas and show the borders of the print pages).

Shape Sizes 
Show/hide the object dimensions

Shape Controls
A set of function buttons becomes available when you select an object. These buttons provide quick
access to some operations that can be carried out with the selected object. 

Page Navigator
This menu is used to display and hide the Page Navigator window.

Hide/Show Library 
This menu is used to display, hide and change the appearance of the library window.

Hide/Show Toolbar
Show/hide the main toolbar.

Customize Toolbar...
Open the Customize dialog where you can set the view of toolbars.

Toggle Full Screen
This command will work to flip in and out of full screen mode. 
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Main Menu View Menu

Functional Buttons

A set of function buttons becomes available when you select an object. These buttons provide quick
access to some operations that can be carried out with the selected object. 

Some objects supplied in the DIAGRAM libraries can change their appearance, or behavior, thanks to
predefined actions. Such objects can be edited by using the menu which is called by clicking the Action

Button ..
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Main Menu View Menu

The Hypernote button .

Activate the Hypernote side panel to manage text notes and hyperlinks added to the object.

The Custom Properties button .

Activate the Custom Properties side panel  to view and edit the object's custom data.

The Smart Connector button .
Activate Smart Connector. To connect objects using this tool, drag the connector a connect point of
another object. You can change the connector's type using the options provided in the Format side
panel.

The Delete button .

Use this button to remove the selected object from a document page.
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Main Menu Insert Menu

Insert Menu

In this menu you can choose drawing tools, insert pages, picture and hyperlinks.

New Page
Inserts a new page to the document. You will see it in the Page Navigator window.
Drawing Tools section 
This section contains commands  that activate tools you need to draw and edit your custom drawings. 
Connectors
This section contains command that activate tools enable you to draw connectors between objects to
display a relationship between them, show the flow of the operation, procedure or logic. 
ConceptDraw DIAGRAM provides a variety of tools for drawing connections between library objects.

Direct Connector
Activates the Direct Connector tool mode and lets you insert the direct connectors between objects.

Direct Connectors are straight lines from the point of origin to the point of contact. Smart , Arc, Bezier
and Curve Connectors are drawn very similarly to Direct Connectors. However, they can automatically
route around objects already placed in your drawing.
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Main Menu Insert Menu

 Arc Connector
Activates the Arc Connector tool mode and lets you  insert the arc connectors between objects.

 Bezier Connector
Activates the Bezier Connector tool mode and lets you  insert the spline connectors between objects.

Smart Connector
Activates the Smart Connector tool.

Curve Connector
Activates the Curve Connector tool.

Use Format panel to customize any selected connector  by changing  the line type, weight, and endpoint
type

Connection Point

Activates the Connection Point tool mode which lets you insert and manipulate connection points of
shapes.

Picture...
Activates a dialog box allowing you to import an image into a document.



Menus

ConceptDraw DIAGRAM   User Interface Reference © 2024 CS Odessa corp.

34

Main Menu Text Menu

Text Menu

This menu contains basic commands for operating with selected text. An expanded set of commands
can be found on the Text panel.

Bold

Makes the text font bold.

Italic

Makes the text font italic.

Underline

Makes the text underlined.

Bigger

Increases the text font size.

Smaller

Decreases the text font size.

Align Left

Set the left alignment for the selected text.

Center

Set the center alignment for the selected text.

Align Right

Set the right alignment for the selected text.

Align Top

Set the top alignment for the selected text.

Align Middle

Set the middle alignment for the selected text.

Align Bottom

Set the bottom alignment for the selected text. 

Text Orientation

The text orientation buttons allow you to change the location of text with relation to an object. You can

shift and rotate a shape's text block. 
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Main Menu Shape Menu

Shape Menu

The commands in this menu allow you to group shapes, change their display order and make various
operations on them. Most popular commands of this menu are also presented in the Arrange & Size
 panel and Main Toolbar to make them more easy to access. 

Ordering
This menu determines the display order of shapes in the document.
Ordering -> Bring to Front
Puts the selected shapes above all other shapes.
Ordering -> Send to Back
Puts the selected shapes behind all other shapes.
Ordering -> Bring Forward
Positions selected shapes one step higher in the order list.
Ordering -> Send Backward
Positions selected shapes one step lower in the order list.
Rotate & Flip
This menu contains commands for rotating and flipping shapes.
Rotate & Flip -> Rotate Left(90°)
Rotates selected shapes by 90° counterclockwise.
Rotate & Flip -> Rotate Right(90°)
Rotates selected shapes by 90° clockwise.
Rotate & Flip -> Flip Vertical
Replaces the selected shape with its vertically mirrored copy.
Rotate & Flip -> Flip Horizontal
Replaces the selected shape with its horizontally mirrored copy.
Group
Groups selected shapes.
Ungroup
Ungroups selected shapes.
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Edit Text
Edits text of the selected shape.
Power Edit
Edit the Shape Parameters table.
Distribute
This menu allows you to create equal spacing between selected shapes.
Distribute -> Horizontal Spacing
Creates uniform horizontal spacing between the alignment boxes of the selected shapes.
Distribute -> Left Edges
Creates uniform spacing between the left edges of the alignment boxes of the selected shapes.
Distribute -> Centers
Creates uniform horizontal spacing between the centers of the alignment boxes of the selected shapes.
Distribute -> Right Edges
Creates uniform spacing between the right edges of the alignment boxes of the selected shapes.
Distribute -> Vertical Spacing
Creates uniform vertical spacing between the alignment boxes of the selected shapes.
Distribute -> Top Edges
Creates uniform spacing between the top edges of the alignment boxes of the selected shapes.
Distribute -> Middle
Creates uniform vertical spacing between the centers of the alignment boxes of the selected shapes.
Distribute -> Bottom Edges
Creates uniform spacing between the bottom edges of the alignment boxes of the selected shapes.
Align
This menu contains commands for aligning two or more selected shapes.
Align -> Left
Aligns selected shapes on the left sides relative to the primary selected shape.
Align -> Center
Aligns selected shapes horizontally on the centers relative to the primary selected shape.
Align -> Right
Aligns selected shapes on the right sides relative to the primary selected shape.
Align -> Top
Aligns selected shapes on the top sides relative to the primary selected shape.
Align -> Middle
Aligns selected shapes vertically on the centers relative to the primary selected shape.
Align -> Bottom
Aligns selected shapes on the bottom sides relative to the primary selected shape.
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Make Same
Makes some attributes of shapes the same as the attributes of the primary selected shape.
Make Same -> Width
Makes the selected shapes the same width as the primary selected shape.
Make Same -> Height
Makes the selected shapes the same height as the primary selected shape.
Make Same -> Size
Makes the selected shapes the same size as the primary selected shape.
Make Same -> Line Properties
Makes the selected shapes contour properties the same as the primary selected shape has.
Make Same -> Fill Properties
Makes the selected shapes fill the same as the primary selected shape has.
Make Same -> Text Properties
Makes the selected shapes text properties the same as the primary selected shape has.
Make Same -> Visual Attributes
Makes all of the selected shapes visual attributes the same as the primary selected shape has.
Operations
Click the drop-down button to access the full list of available operations with objects containing in the
Basic Shapes library.
Crop
You can crop the inserted image to remove any unwanted areas.
Fit to text
Resizes the selected shapes according to the dimensions of the text they contain.
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Tools Menu

This menu contains various tools.

Script Editor
Opens Script Editor for editing ConceptDraw Basic scripts.

Select
Activates the Select tool mode.

Select Text
Activates the Text Selection tool when you need to edit a text in ConceptDraw DIAGRAM document. 
Click the mouse once to activate the edit mode. Double-click to select the entire word.

Grid & Rules...
Calls the Grid & Rulers dialog, where you can change the parameters for the grid and rulers.
For more information see Dialogs - Modal Dialogs - Grid & Rulers.

Snap & Glue...
Allows to modify snapping and gluing parameters for shapes.
For more information see Dialogs - Modal Dialogs - Snap & Glue,
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Connector Jump Type
This menu specifies how the points in which smart connectors cross look like.

Connector Jump Type -> Square
Displays a square crossing.

Connector Jump Type -> Arc
Displays an arc crossing.

Connector Jump Type -> 2 Sides
Displays a crossing made up of two lines.

Connector Jump Type -> 3 Sides
Displays a crossing made up of three lines.

Connector Jump Type -> Gap
Displays a gap on crossing.

Connector Jump Orientation
Specifies the orientation of line crossings.

Connector Jump Orientation -> Horizontal Jumps
The line crossings will be displayed on the horizontal lines.

Connector Jump Orientation -> Vertical Jumps
The line crossings will be displayed on the vertical lines.

Connector Jump Orientation -> No Jumps
No line jumps are displayed.
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Rapid Draw Mode
Activate Rapid Draw mode for selected object(s).

Tree Connection Mode
Activate the Tree Connection Mode.
Connect  selected objects with  Connectors in a tree structure. New object will  be automatically
connected to selected one.

Chain Connection Mode
Activate the Chain Connection Mode.
Consistently connect  selected objects with  Connectors. New object will  be automatically connected to
selected one.

Text Auto Expand Mode
Activates the Text Auto Expand mode in which any shape is resized automatically when you add text
to it. 
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Inspectors Menu

This menu controls which inspectors are displayed. The check mark  besides the menu items
indicates that the floating dialog is active and is displayed either as a side panels, or as a tab in one of
the side panel. Clicking on a menu item displays the dialog if it was hidden, or hides it if it was visible.

Show/Hide Inspectors
Enables you show the latest active panels , or hide the currently opened panels. 

Solutions
Shows/hides the Solutions panel.
For more information see Dialogs - Side Panels - Solutions

Pages
Shows/hides the Pages panel.
For more information see Dialogs - Side Panels - Pages

My ConceptDraw
Shows/hides the My ConceptDraw panel.
For more information see Dialogs - Side Panels - My ConceptDraw

Layers
Shows/hides the Layers panel.
For more information see Dialogs - Side Panels - Layers.

Show/Hide  Library
Shows/hides the Library panel.
For more information see Dialogs - Side Panels - Library

Arrange & Size
Shows/hides the Arrange & Size panel.
For more information see Dialogs - Side Panels - Arrange & Size
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Format
Shows/hides the Format panel.
For more information see Dialogs - Side Panels - Format

Text
Shows/hides the Text panel.
For more information see Dialogs - Side Panels - Text

Hypernote
Shows/hides the Hypernote panel.
For more information see Dialogs - Side Panels - Hypernote

Info
Shows/hides the Info panel.
For more information see Dialogs - Side Panels - Info

Custom Properties
Shows/hides the Custom Properties panel.
For more information see Dialogs - Side Panels - Custom Properties

Advanced
Shows/hides the Advanced panel.
For more information see Dialogs - Side Panels - Advanced

Presentation
Shows/hides the Present panel.
For more information see Dialogs - Side Panels -Presentation
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Window Menu

This menu contains commands for manipulating windows, and shows the list of open windows

Minimize
Minimizes the active window to the Dock. Changes to Minimize All when the Option key is pressed.

Expand Window
Expands the active window.

Tile Window to Left of Screen
Tile Window to Right of Screen
Arrange tiled windows in Split View (macOS Catalina and higher) to the left or right side.

Replace Tiled Window
Allows you to use a different app on one side (since macOS Monterey) when using the Split View.

Remove Window from Set
Featured by macOS Ventura's Stage Manager: if multiple windows are open on your current stage, you
can use the ‘Remove Window from Set’ command to return it to the strip. 

Bring All to Front
Brings all ConceptDraw DIAGRAM windows to front, maintaining their onscreen location, size, and
layering order. Changes to Arrange in Front when the Option key is pressed. In the bottom section of this
menu the windows list is located.
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Help Menu

From this menu you can get reference information.

 

 
Search
Lets you search through menu items

Send Feedback to Apple
You can submit a ConceptDraw DIAGRAM feedback to Apple 
 
ConceptDraw DIAGRAM Help
Calls the ConceptDraw DIAGRAM Help System. It opens in a separate window where you can see a
number of articles containing information on how to use the product. You can read or print the articles,
search them for the needed information.
 
Keyboard Shortcuts
Calls the ConceptDraw DIAGRAM keyboard shortcuts description.
 
Getting Started 
Open the Getting Started guide in the PDF format

Online Help Desk
Access the ConceptDraw Help Desk web pages.
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Context Menu

Context menus offer the set of choices that are available in the current state, of the  application. Usually
the available choices are actions related to the selected object.

ConceptDraw DIAGRAM provides a set of context menus related to different objects:

Object context menu
Text context menu
Toolbar context menu
Library context menu
Library Item context menu
Pages context menu
Table  context menu
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Object Context Menu

The appearance of the context menu of the document may vary depending on where you call it - on a
shape, or on an empty area in the document window. When you right-click on a shape, the context
menu will look as follows:

When you right-click on an empty area, the context menu will look as follows:
Cut
Cuts selected text or shapes and copies them onto the Clipboard.
Copy
Copies selected shapes or text onto the Clipboard.
Paste
Inserts the contents of the Clipboard into the document.
Delete
Deletes selected shapes.
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Fit To Text
Resizes the selected shapes according to the dimensions of the text they contain.

Object
This menu is used to change position of shapes in the document.
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Send To Back: Puts the selected shapes behind all other shapes.
Bring To Front: Puts the selected shapes above all other shapes.
Rotate Left(90°): Rotate selected shapes by 90° counterclockwise.
Rotate Right(90°): Rotate selected shapes by 90° clockwise.
Flip Horizontal: Replace the selected shape with its horizontally mirrored copy.
Flip Vertical: Replace the selected shape with its vertically mirrored copy.
Edit Text: Edit text of the selected shape.
Group: Group selected shapes.
Ungroup: Ungroup selected shapes.
Hypernote: Opens the Hypernote Inspector
Lock: Allows to lock some of the shape parameters.

Custom Properties: Opens Custom Properties panel
Power Edit: Opens the Shape Table View .
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Text Context Menu

ConceptDraw DIAGRAM allows you to access the most frequently used operations with text via the
context menu. There are different ways to select  a text. You can select a desired piece of text using the
Text Selection Tool, or you can select the entire text using the Edit Text command from the Object
context menu.

Look Up
Look up the selected text in Thesaurus and Dictionary.
Translate
You can translate text a macOS system translation feature.
Search with Google
Search the selected text in Google.
Cut, Copy, Paste
You can perform the common operations with a selected text the same as with object.
Share
Item is embedded in macOS system. Displays the list of available sharing services. Provides users a
convenient way to share content with other entities, such as social sharing websites or upload services. 
Substitutions
With Apple's standard Substitutions feature, you can automatically replace text and punctuation. For
example, you can automatically replace a double-space with a period and a space, or replace straight
quotes with “curly” quotes (called smart quotes). You can also have Internet addresses (URLs) converted
to clickable links (called smart links).
Transformation
With Apple's standard Transformation feature, you can perform a certain text transformations.
Speech
With Apple's standard Speech feature you can use your voice to enter text on your Mac.
Layout Orientation
With Apple's standard Layout Orientation feature you can change layout of the text.
Services
Customizable Apple System Menu. Access it through System Preferences> Keyboard> Shortcuts>
Services.
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Toolbar Context Menu

When you right-click on the toolbar, the context menu will look as follows:

Icon&Text
Both icons and text will be displayed on the toolbar.

Icon Only
Display only toolbar buttons icons.

Text Only
Display only toolbar buttons text labels

Use Small Size
The buttons icons size will be decreased.

Customize Toolbar
Calls the Customize Toolbar dialog where you can add or remove the buttons from the toolbar.
For more information see Dialogs - Modal Dialogs - Customize Toolbar .
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Library Context Menu

This menu appears when you right-click on a free space in the library window on the Solutions panel.

New
Create a new library.

Open
Open an existing library from Finder.

Save
Save changes.

Save As
Save changes as another library.

Show File Location
Reveal the selected library in Finder.

Properties
Open the Library Properties dialog. 
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Library Item Context Menu

This menu appears when you right-click on a shape in the library window.

New Library
Create a new empty library.
Close Library
Close the currently opened library.
Close All Libraries
Close all libraries.
Save  Library
Save changes in the existing library using the Save As dialog.
Save Library as
Save a new library using  the Save As dialog. 
Show Library File Location
Show where the library is stored on the disk
Library Properties
Open the Library Properties dialog
Cut
Cuts the selected library shape and copies it onto the Clipboard.
Copy
Copies the library shape onto the Clipboard.
Paste
Pastes the shape from the Clipboard into the library.
Delete
Removes a shape from the library.
Replace
Replaces the selected shape in the library with the selected shape in the document without changing the
icon.
Change Icon
Opens Finder window to select graphic file to replace the icon of a library shape.
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Properties
Opens the Library Item Properties dialog.
View as Icons
Shows shapes in the library window as icons.

View as Icons and Text
Shows both the names and the icons of the shapes in the library window.

View as Icons and Text Right
Show both the names and the icons of the shapes in the library window on the right. 
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Pages Context Menu

This menu appears when you right-click on a free space in the library window or on the page navigator
arrows in the left bottom corner of the document window.

Add Page
Addt a blank page at the end of a document.
Insert Page
Insert a blank page after the currently selected page.
 Duplicate Page
Insert a copy of  the currently selected page.
Delete Page
Delete the selected pages.
 Rename Page
Rename the selected page.
Go to Page
Open the Pages list to instantly switch to the selected page.
Choose Background
Choose a page to be a background for the selected page.
Set as Background for
Set the selected page as background for other pages in a document.
Adjust to Drawing Content
Make the page fitting to content.
 Properties
Open the Page Properties dialog.
Create New Document
Copy selected page to a new document
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Views

You can process a ConceptDraw DIAGRAM document using the Document window,  Library windows
and Pages view. 
You also have the option of viewing and editing objects' properties  using Basic Script Editor, or Shape
Parameters Table view.  Presentation view shows the slide presentation from current document.
Slides will be created from document's pages.

Document
Library
Pages
Basic Script Editor
Shape Parameters Table
Presentation
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Document

This window is used for working with the document.
The default document window looks as follows: On the left side there are Solutions and Library panels.
On the left and top sides of the window you can see the rulers. The grid helps to position shapes more
precisely.
On the right side, you can see the Side Panels. These panels are the main means of communication
between the application and the user. You can use them to set various components and properties of the
application's functions. The side panels also provide information.

You can change the appearance of the document window. You can display or hide the grid and rulers.
The grid and rulers parameters are set in the Grid & Rulers dialog, which you can call from the Tools
menu.

To display/hide the rulers, the guide lines and the grid, use the View menu. To show/hide the rulers, use
the View / Rulers menu; to show/hide the grid use the View / Grid menu, to show/hide the guide lines
use the View / Guides menu. Sometimes a document can be larger than one printer page. In this case
the program will break the document down and arrange it on several printer pages. To view the page
breaks, enable the Page Breaks option in the View menu.

For for easy editing you can zoom in or out on the document by using the View / Zoom menu, the
Zoom slider below the main toolbar, or the Zoom toolbar.
When you right-click somewhere in the window, the context menu appears. It contains various
commands for working with shapes. For more information about this menu see Menus - Document
context menu.
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Basic Script Editor

Each ConceptDraw graphical object has a set of properties that define its view and functionality in the

application. ConceptDraw offers 3 ways to access properties of objects: a Shape Parameters Table, the

ConceptDraw Basic script and XML. Open  Basic Script Editor using menu Tools/Script Editor.

ConceptDraw Basic Script helps to interact with other applications (command line running, invocation of

the custom functions from external libraries). The ConceptDraw Basic Editor window is used for writing

and debugging ConceptDraw Basic scripts.

It represents a simple text editor that allows to copy and paste text. Additionally, it allows to include
source codes into the scripts (by using the #include statement). To compile and execute the script use
corresponding buttons from the toolbar. To open the Output window press the button Toggle Output.

You can click on the lines to select them and copy the lines onto the Clipboard. This window is helpful
for finding syntax errors in the source code. Just double-click on the error in the output window, and the
program will open the editor window, with the cursor placed on the line which caused the error.
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Shape Parameters Table

Each ConceptDraw graphical object has a set of properties that define its view and functionality in the
application.  With the help of Shape Parameters table you can define the logic of the objects’ behavior,
apply them the arbitrary appearance and set the connection between the appearances of different objects
as well as create complex objects.
You can open the Shape Parameters table using the from the Shape / Power Edit menu.

The object properties table gives the opportunity to work with the already defined set of parameters and

properties of an object. It is designed to manage the limited (including large) set of properties.

At the top of the table there's the input field where you can enter or alter the parameters in the cells. All
parameters are grouped in sections. By double-clicking a section title you can collapse it to one row.
When you click a cell in a section, its content is displayed in the input field where you can edit it. Also
you can make changes using the Table context menu.
For more complex objects, objects with a variable number of child elements and custom properties, as

well as a predetermined behavior ConceptDraw Basic script is recommended.
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Presentation

This window is used for previewing the document as a slide-show. Slides will be created from document's

pages. Use Present panel to conduct the presentation. Click the  button on the Main Toolbar.

Presentation view shows the slide presentation from current document. Slides will be created from
document's pages.

The document page will be stretched to fit the window.
In the bottom part of the view there is page navigator window. To open it hold the mouse cursor in the
bottom part of the window for several seconds. You can move between pages by pressing Space key,
clicking arrows or pages icons.
To quit the view press Esc key.
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Dialogs

Dialogs are the main means of communication between the program and the user. They are used to set
various components and properties of the program. The dialogs also provide information. ConceptDraw
has two types of dialogs:

Modal Dialogs
Side Panels                              
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Modal Dialogs

Modal dialogs are mostly called from the menus, or by using the keyboard shortcuts. When this dialog is
open, you can't work with other  tools.

Document Properties
Preferences
Spell Check
Color
Find&Replace Text
Library Item Properties
Library Properties
HTML Export Dialog
Flash Export (SWF) Dialog
Graphic File Export
Page Setup
Print
Grid&Rulers
Snap & Glue
Customize Toolbar
Page Properties
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Document Properties Dialog

 This dialog is used to set the parameters of the current document. To call it choose Document
Properties... from the File menu. The dialog contains several tabs, which control various groups of
settings:

Print Setup - contains information that describes the document.
Page Size - sets the size and orientation of the document pages.
Units - sets the scale, units of measure, etc.
Info - contains information that describes the document.
Advanced - allows to protect the document by restricting access to it.

Print Setup

The Print Setup settings allow you to set options for the default printer and its default settings.

 

Printer Setup - opens the system printer settings dialog.

Print Zoom - lets you adjust the document pages to the printer pages.

Print background pages separately - lets you print the background pages of the document as
separate pages.
Print grid lines - lets you hide or show grid lines on the printed page.
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Page Size
The Page Size settings allow you to choose the size of the document page.

Select the different Page Size to see more page size options. You can choose one of the pre-defined
sizes from the drop-down list or set Custom page size. Using the pre-defined sizes you can only change
the paper orientation. Also you can set exact size of paper.

Width - specifies the page width
Height - specifies the page height

The Orientation setting specifies the orientation of the document page: Portrait - the page is taller than
it's wide. Landscape - the page is wider than it's tall.
Adjust to Drawing Contents - the page size is set enough to fit all shapes in the drawing. If the document
contains several pages, the biggest value is used. If you want to print the background page separately
mark the corresponding option.
Expand the page in Rapid Draw - Sometimes, when you create charts using Rapid Draw, not all objects
can be  placed on a given page size. This option allows you to enable automatic expansion of the page.
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Units
The Units settings allow you to choose the units of measurements for a page’s dimensions, margins,
drawing size, and drawing scale. The units you choose determine whether new, blank drawings open
with metric or U.S. units.

 Units - allows to choose the unit of measure from the drop-down list.
Angle - sets whether to display the angles in degrees or radians.
The Scale setting determines the scale of the document. The following options are available:
No scale (1:1) - the 1:1 scale.
Pre-defined scale - allows to choose a scale from the list. The scale is set with the help of two
drop-down lists. The first one allows to choose the type of the drawing:

· Metric
· Civil Engineering
· Mechanical Engineering
· Architectural

Depending on the chosen option you can choose a pre-defined scale in the second drop-down list. If
the Civil Engineering or Architectural options are chosen, non-metric (imperial) units of measure
are set automatically in the Units of measure field. You can change the units of measure manually if
needed.
Custom scale - sets a user-defined scale. You can use different units of measure by specifying the
appropriate suffix after the value (for example, 1 ft = 1 in).
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Info
The Info settings contain the current document meta description and author info.

Title - contains the title of the document
Subject - contains the subject of the document
Author - contains the name of the author
Company - contains the name of the company
Comments - a detailed description of the document
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Advanced

The Advanced settings allow you to manage access to the current ConceptDraw DIAGRAM
document.

Protect Access to Document - It allows you to restrict access to your ConceptDraw document.
You can create a list of users who are allowed to access the document. You can manage the access
list using the "Add User", "Edit User" and "Remove User" buttons .
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Settings Dialog

This dialog controls the application settings. It allows you to change default application settings that will
be applied to all new documents created in ConceptDraw DIAGRAM. 
To call the dialog, choose Preferences from the Application menu.
The dialog contains several tabs, where various settings are grouped:

General - contains the default settings for new documents,
Document - specifies paths to various components of the application,
Script Editor - determines the appearance of some components of the application,

The General tab:

If you want to mark hyperlinks in text use the Detect & Mark  Hyperlinks in Text option.
Undo Depth -  The Undo command reverses recent changes, the amount of which is determined by the
Undo Depth option.
Snap sensitivity - sets the distance at which snapping and gluing are activated. This distance is set in
pixels and does not depend on the scale or magnification. The default value is 15 pixels.
Make a Backup Copy - mark this option to enable auto saving.
Keep original format for inserted images - enable to insert images keeping their original format.

View Options:

Use mouse scroll to change zoom - enable using mouse to change zoom.

Use the Enter and Esc keys for objects navigation -  Navigate from object to object using keys in

addition to using the mouse.

Embed objects into a connector path - enable to  insert an object directly in the connector path.

Alignment box thickness -  lets you adjust the thickness of the selection box. It may be important for
object alignment.
Edit Text Mode Options:
You can set the operation which will be perform by the Enter key in the Text Edit  mode.  
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The Document tab:

This tab describes the parameters of the documents, created with the New command. You can choose

whether to base a new document on the default settings or on a default template file:

Create New Document Using:
Custom Template- allows to choose a template file, on which every new document will be based. Use
the Browse button to choose the file, or specify the path in the edit field.
Default  Settings - indicates, that the document is created with the default parameters, listed in the
Template Setup dialog.

The Script Editor tab:

The Script Editor tab specifies how the CDBasic Editor window looks and works.
The Script Settings section sets how ConceptDraw Basic scripts will be treated by ConceptDraw:
Allow Script Running - allows the program to run scripts automatically,
Allow Script Editing - allows to edit scripts.
You can choose the font and font size, and preview them in the area below.
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Spell Check Dialog

You can use the Spell Check dialog to find mistakes in the shapes text.
You can call this dialog from the Edit menu.
When you call the dialog, the Spell Check engine checks all objects in your document at all pages. You
will see the results of the check in the next dialog.

The mistakes are marked red and underlined. You can select one of the words from the internal
dictionary and correct a mistake by pressing the Guess button.
You can find out what  selected word means by using the Define button.
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Color Dialog

This dialog is used to set color for a shape, its text or other attributes. You can call this dialog by

pressing one of the buttons located in the Color  drop-down list from the appropriate toolbar button
menu.

  

   

This is a standard macOS system color dialog where you choose a color, adjust its brightness. To
choose the needed color, click on it with the mouse.You can add the chosen color to the custom colors
area in the bottom part of the dialog by dragging it from the sample area in the upper part of the dialog. It
works on any tab of the dialog. 
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Find/Replace Dialog

This dialog allows you to search for and replace text in ConceptDraw shapes. The search can be
performed either in the current document, or in the documents on disk (including folders and subfolders).
You can edit the document without closing this dialog - it remains floating over the document, and you
can always return to it and search for the next match. You can call the dialog from the Edit\Find\Find...
menu or by using the keyboard: Cmd + F

The Find&Replace dialog:

Find What - here you can specify the string to be found. You can either type the text, or select one of
the previously searched strings.

Replace With - a string with which the found string will be replaced.

Match Case - specifies whether to differentiate capital and small letters in the search.

Whole Words - search only complete words. For instance, if "leg" is being searched, the "leg" world will
be found, and "legion" or "legend" will be ignored.

In: - drop-down list with search location options.

Replace All - replaces all matches with the string in Replace With.

Replace - replaces the found string with the string in Replace With.

Previous - returns to the previous match.
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Library Properties

This dialog is used to view and set library properties.
You can call this dialog from File\Library\Properties or from the context menu in the library window.
The Library Properties dialog:

Title - the name of the library.
Subject - the brief description of the library.
Author and Company - information about the creators of the library.
Description - additional information about the library.
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Library Item Properties

This dialog is used to view and set the properties of library shapes.
You can call this dialog from the library item context menu in the library window.
The Library Item Properties dialog:

 Item name - sets the name of the library shape.
Item prompt - sets a brief description of the library shape.
Item Keywords: - Here you can enter keywords regarding the library object

These properties are displayed when you position the mouse pointer over a shape in the library. The Item
name appears as a tip over the shape, and the Item prompt is shown in the status bar.
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HTML Export Dialog

This dialog is used to set exporting parameters for HTML.

There is a gallery of templates in the top part of the dialog. To choose a template make a click on its
icon. To export the current document with the default settings make a double-click on chosen template
icon.
Process Linked ConceptDraw Documents - process all linked ConceptDraw documents like the current
document, so you will be able to open them as regular HTML files from the exported HTML file.
Export Current Page Only - export only current page of the document.
Export pages as images - export the content of ConceptDraw document as *.png image inserted into
html page.
Open Exported Page - open exported HTML file after export using default Web-browser.
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Flash Export Dialog

This dialog is used to configure the parameters of the resulting .swf file when exporting the document to
Macromedia Flash format.
This dialog is called from the menu File / Export / Flash.
The Flash Export Settings dialog: The Slide Show setting specifies when the next page of a multi-page
document will be displayed:

None - only the first page is displayed.
Mouse Click  - the next page will be displayed on a mouse-click.

Use Navigation Buttons the following navigation buttons will be inserted into the Flash file:

Go to first page
Go to previous page
Go to next page
Go to last page

Timer - the next page will be displayed in the specified time interval (in seconds).
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Graphic File Export

This dialog is used to configure the parameters of the resulting .graphic file (PNG, JPEG, GIF, TIF, BMP,
PCT)  file when exporting the ConceptDraw  document to graphic format. This dialog is called from the
menu File / Export / Graphic file.

In the Image Size section, you can choose one of these options:
Original - the shapes will be exported in their original size, regardless of the current zoom level.
Use document zoom - the shapes in the graphic file will be of the same size as they appear on screen
(at the current zoom level).
High Quality - choosing this option, you'll get the best quality image. Please note, that the size of the file
would increase. We recommend to use the option for printing.
Fit to size - this option lets you assign custom dimensions to the picture - specify the width and height
in pixels.
Pixel density - this option lets you change a pixel density (PPI).

In the Export section, you specify which  shapes will form the image in the graphic file:
All document pages separately - create a separate graphic file for each page of the document.
Whole page - to export the entire page with all the shapes which are within the page.
All objects on page - all the shapes which are on the page and outside it. The image size will be large
enough to fit for all shapes.
Selected  objects - only the selected shapes from the active page. The image size will be equal to the
total bound of all selected shapes.
All document pages - select when export to animated GIF.
Time interval (GIF) - set the time interval to show the animated GIF slides.
Quality - for JPEG format you can also specify image quality: by using the slide bar, you can set the
quality within the range of 1% to 100%. Note that better quality increases the file size.
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Page Setup Dialog

This is a standard system dialog which is used to configure the printer page settings.
You can call the dialog from the File\Page Setup menu or by using the keyboard: Cmd + Shift + P
The Page Setup dialog:

Format for - allows to choose the printer to adjust the page for.
Paper Size - sets the page size.
Orientation - sets the page orientation.
Scale - sets print scale.
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Print Dialog

The Print dialog is a system dialog, which allows you to specify the printer, the range of pages to be
printed, the number of copies, and some other settings.
You can call this dialog from the File\Print menu or by using the keyboard: Cmd + P
The Print dialog:

Printer - allows to choose a printer from the list.
Copies - number of copies.
The Pages section sets the print range.
PDF -  You can share the document with others by saving it as a Portable Document Format (PDF),
PostScript file, cloud storage, or emailing it.
Show Details/Hide Details - Display all print options/simplify the display of commonly used options.
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Grid Settings Dialog

This dialog is used to configure the view of the grid and the rulers. This dialog can be called from the
Tools\Grid & Rulers... menu.

The Grid Spacing section specifies the size of the grid cells.
Horizontal - sets the width of the grid cells:

Normal
Fine
Coarse
Fixed

The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
Vertical - sets the height of the grid cells:

Normal
Fine
Coarse
Fixed

The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
The Grid Origins -sets the starting point (origin) for the grid lines. The origin represents the horizontal
and vertical offset relative to the upper left corner of the page.
Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
Vertical - vertical offset. The possible range is -320 mm to +320 mm.
The Rulers Origins -sets the starting point (origin) for the rulers. The origin represents the horizontal and
vertical offset relative to the upper left corner of the page.
Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
Vertical - vertical offset. The possible range is -320 mm to +320 mm.
The Grid Color section specifies the grid color and alpha channel settings of the grid.
The alpha channel controls the opacity of a grid. You can change the transparency of the grid using the
opacity option in the range  from 0 to 100%
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Snap and Glue Settings Dialog

This dialog is used to configure the snapping and gluing settings.
You can call this dialog from the Tools\Snap & Glue... menu
The Snap & Glue dialog:

If Snap to is enabled, you can specify the conditions when snapping will be activated.
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Customize dialog

This dialog is used for customizing the user interface of the program (menu commands, toolbars,
keyboard shortcuts).
This dialog is called from the View\Customize Toolbar... menu of from the context menu, called on the
toolbar.

You can drag the buttons or toolbar elements such as Separator, Flexible Space or Space from the list
to the toolbar with the mouse.
To delete a command from a menu or a toolbar, grab it with the mouse and drag back onto the dialog
window.
Also you can drag the whole default set of the buttons instead of the customized toolbar.
Show - defines the style of the buttons on the toolbar.

o Icon&Text - shows both icons and text
o Icons only - shows only buttons images
o Text only - shows only buttons signs

Use Small Size - mark this option if you want to decrease the size of the toolbar buttons icons
Press Done to finish customizing.

 



Dialogs

ConceptDraw DIAGRAM   User Interface Reference © 2024 CS Odessa corp.

82

Modal Dialogs Page Properties Dialog

Page Properties Dialog

This dialog is used to view and the page properties.

You can call this dialog from the Pages inspector context menu.

The Page Properties dialog:

Title - the name of the Page
Description - Short description of the page content.
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Template Setup Dialog

This tab contains settings of the default template. Starting with the New document and selecting the
Default document option, you get the workspace corresponding to these settings. Enables you to set 
properties of a new document. Template setup includes two steps:
Step 1: Setup a  page and printer paper properties.

Step 2 Enables set a  Grid and Snap properties.

Template settings will be automatically applied when choosing Custom Settings option in the
Preferences' Document tab. 
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Side Panels

Some tools and features in ConceptDraw DIAGRAM are accessible from the side panels. You may find
here particular tools and resources  that you might need while working with graphic documents. Click the
Inspectors menu to find a needed panel.

Solutions
Pages
Layers
Show/Hide Library
Arrange&Size
Format
Text
Hypernote
Info
Custom Properties
Advanced
Presentation
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Solutions

ConceptDraw DIAGRAM provides an  access to an online service  that  delivers  additional product
extensions. This is a time saving assistant for generating business documents and presentations.
ConceptDraw Solution Park is an online collection of visual solutions for  ConceptDraw products. It
contains many subject areas for professional applications. Solutions panel provides the list  of available

solutions in alphabetical order. You can activate Solutions inspector  by clicking the  button on the
toolbar, or using the  Inspectors menu.

1. Search window.  You can search for library objects. Enter a keyword or an object name in the
search field. The object will be found and displayed in the Library panel, also solutions displayed in the

Solutions panel will be filtered according to the keyword.
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2. Search in ConceptDraw Store. You can run the ConceptDraw Store application to search for the the
proper solution in Solution Park.

3. Solution section. This section contains the list  of available solutions in alphabetical order. Use the
drop-down button to preview Libraries, Templates and Samples contained in the certain solution. You can
open them by click.

.  
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Pages

The Pages panel enables you to operate  with pages of a current document. You can activate Pages

inspector  by clicking the  button on the toolbar, using the  Inspectors menu, or the Page Navigator
command from the menu View.  There are two page viewing modes. To switch between modes, use the
tabs at the bottom of the Page panel. To add or delete a page open the context menu by making the
right mouse click on the page.

Preview Mode
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Tree Mode
The Tree view of the page shows the diagram as a hierarchical list of objects. Moving the cursor through
the list, you navigate through the diagram's objects.
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The pages of your ConceptDraw DIAGRAM document displayed as icons with previews, so you can
easily navigate through your document.
The active page preview.

Double-click name to rename page.To reorder pages use drag & drop.
If the page has background, it is marked with a background icon.

Preview of the page, that is assigned to be a background page.



Dialogs

ConceptDraw DIAGRAM   User Interface Reference © 2024 CS Odessa corp.

90

Side Panels Layers

Layers

You can activate Layers inspector  by clicking the  button on the toolbar or using the  Inspectors
menu. This inspector is used for working with layers. It contains the list of existing layers and their
properties.

The table contains six columns: Name, Active( ), Visible( ), Lock ( ), Printable( ) and Color.
Name - indicates the name of the layer. The active layer is displayed in blue, the selected layer (which is
being edited) is highlighted. To select another layer, click on its name with the mouse. Double-clicking
on the name (or pressing F2) let you edit the name of the layer.
Active - specifies whether the layer is active.The active layer is the layer on which new shapes are
placed. The active layer is marked with the  sign. Only one layer can be active at a time.

Visible - specifies whether the layer is visible. The eye sign ( ), indicates that the layer is visible
(invisible), that is, the shapes on the layer are visible (invisible).

Lock  - specifies whether the layer is locked against changes. The padlock sign ( ) indicates that the
layer is locked (unlocked). You can't edit shapes on a locked layer.

Printable - specifies whether the layer is printable. The printer sign  indicates that the layer is printable
and the shapes on it will be printed.

Color - specifies the color of the shapes on the layer. If the check mark  is set, the line color of all
shapes on the layer will be the same as the color of the color box near the check mark. Otherwise the
shapes have their original line color.

Add  - adds a new layer to the document. The new layer gets default settings: not active, visible,
unlocked, printable, without color.

Delete  - deletes the selected layer. All shapes that are on the deleted layer are automatically placed
on the active layer. You can delete the active layer, and there's always at least one layer in the
document.
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My ConceptDraw

My ConceptDraw panel displays DIAGRAM's stuff stored in the My ConceptDraw folder on the user's
computer. 

· Document files in CDD and CDDZ format;
· Library files in CDL format;
· Template files in CDT format;

· Slide presentations in CDS and CDSZ format.

Subfolders are also displayed if they contain these formats of documents. Create a shortcut to any folder
using Windows Explorer, place it in the My ConceptDraw folder and it will also be displayed on the My
ConceptDraw panel as a subfolder. You can drag documents between folders.You can drag documents
between folders. Access the panel from the Main Toolbar. When you hover over a document icon, a
tooltip appears that contains a preview and document metadata. The context menu allows you to create
a new document, delete a document, adjust the preview size, sort previews by name or date, and show
the location of the document (folder with the document in Finder). The search bar makes it easy to
navigate folder's  content.
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Library

To open the library window click the  button on the toolbar,  use the  Inspectors menu, or the

Show/Hide Library command from the menu View.  Wide collections of shapes and Clip arts help you
create a different types of diagrams, as well as various sorts of technical drawings.

1. Libraries section  displays the opened libraries. You can cause a list of opened libraries by using the

drop-down button. Press the navigation arrows   to navigate through libraries.

You can manage the libraries using the context menu and Library Properties Dialog.

2. Objects section displays objects containing in the active library.  There are a few different methods for
placing an object into your drawing:
· Click on an object and then click on the document, at the place you want the object to be inserted.
· Perform a drag-and-drop from the library to your document.
· Double click on an object’s icon in the library to place an object in the center of your document.

You can manage library objects using the context menu and Library Item Properties dialog. 
You can change the fill color of the object, the line type, add a shadow, or apply other formatting options
using the Format panel.
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Some of ConceptDraw libraries contain objects, identified by a blue tile in the library preview. Such

objects can be edited by using the Action button   menu. To open the menu select an object and
click the action button in the upper right corner of the object.

Some ConceptDraw DIAGRAM objects are assigned embedded Rapid Draw features. Rapid Draw allows
you to build diagram quickly. Select a Rapid Draw featured object.  

You can add the next object by clicking on its icon from the Rapid Draw arrows that pop up when you
bring the mouse cursor over the object. 

 Rapid Draw will automatically draw and connect the next object in your drawing. 
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Arrange & Size

Arrange & Size panel is included to the Format group of control panels. Activate it using  button on
the main toolbar, or the Inspectors menu.
ConceptDraw DIAGRAM provides tools to help ensure the shapes in your diagram are aligned and
spaced well. That helps make your drawing as clear as possible and give it a professional look. Access
the Arrange inspector from the Inspectors menu.

· Order
Here are object order tools. They help you control the placement of overlapping objects.
· Align and Distribute
Align shapes without changing their spacing using the Left, Central, Right controls to set a horizontal
alignment and Top, Middle and Bottom controls to set a vertical alignment.
Distribute the space between object's control frames using the Vertical and Horizontal distribution. 
· Align to Page
Align selected objects relative to the edges of the page.
· Size
Set the size of the object in the units specified in the Preferences.
· Position
Set the position of the object in the coordinate system. 
· Rotate and Flip
You can rotate objects rotated clockwise and counterclockwise in 90 and 180 degrees . You can  flip
them vertically, flip them horizontally, or rotate using the Angle and Pin.
· Group and Lock 
You can group Group and Ungroup selected objects. The Edit group button allows you to change
objects within group using a special window for edits.. 
· Make Same
You can make the certain properties of selected objects identical.



Dialogs

ConceptDraw DIAGRAM   User Interface Reference © 2024 CS Odessa corp.

95

Side Panels Format

Format

ConceptDraw DIAGRAM provides tools to help ensure the selected objects in your diagram are aligned
and spaced well. That helps make your drawing as clear as possible and give it a professional look. 

You can activate the Format panel  by clicking the  button on the toolbar or using the  Inspectors
menu.

Format Panel for a Library Object

· Style
You can apply pre-designed formatting to your drawing with one click. The embedded style themes can
be applied to an entire object (fill, line and text) or to object's elements, such as line, and text. You can
create your own style containing custom colors, effects and text formatting by choosing one of the
embedded styles and modifying it. You can save a new style in your current ConceptDraw DIAGRAM
document, or save it on your local computer to be used with other ConceptDraw DIAGRAM documents.

Use the icon to save , or load custom themes.

· Fill
Change the fill color of selected object.
· Border
Change line color and line pattern.
· Shadow
Select shadow style and color.
· Make Same Attributes
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Format Panel for  Connector

· Style
Built-in style themes can be applied to connectors as well as to entire objects (fill, line, and text). Using
the Style section for connectors is the same as for the 2D objects described above.
· Connector Type
Change the type of connector.
· Stroke
Change the type of the stroke of the selected connector.
· End Points
Change the form and size of the arrowheads of the selected connectors.
· Margins and Path
You can  create connectors that do not have a visible connection to
the objects by adding two-sided margins, or one-sided indents - path.
· Make Same Attributes
Make certain properties of selected objects identical.
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Format Panel for a Raster Image

· Brightness 
You can adjust the brightness of all colors and the difference between the light and dark parts of an
object.
· Contrast 
You can change the contrast of the color of a bitmap while preserving shadow and highlight detail. 
· Gamma 
The Gamma effect enables picking up details in a low contrast image without significantly affecting the
shadows or highlights.
· Saturation 
You can adjust the colors and their intensity by changing the percentage of white in the image. 
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Text

Text panel is included to the Format group of control panels. Activate it using  button on the main
toolbar, or the Inspectors menu.
ConceptDraw DIAGRAM provides tools to set or modify various attributes of the shape's text..  You can
change the format of text in a selected shape using text formatting options. Access the Text inspector
from the Inspectors menu.

 1. Font 
Font - allows you to choose a font from the list of installed fonts and define the font size in points. 1 point
= 1/72 inch.
Upper color selector - sets the text color. You can choose a color from the color palette, or set a custom
color.
Upper opacity slider - sets the text transparency.
Lower color selector - sets the text background color. You can choose a color from the color palette, or
set a custom color.
Lower opacity slider - sets the text background transparency. You can apply any style to font: Bold,
Italic, Underline, etc.
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2. Alignment :
The Horizontal Alignment section describes how the paragraph is aligned relative to the shape's text box.
The following alignment types are available:
Left - to the left side of the text box,
Centered - the lines are justified with respect to the center of the text box.
Right - to the right side of the text box.
Top - moves the text to the top of the text box,
Middle - centers the text in the middle of the text box,
Bottom - moves the text to the bottom of  box.
Text auto expand mode - If the object should contain a lot of text, this mode allows you to automatically
increase the width and height to accommodate the text in full.

Text auto expand mode "OFF"       Text auto expand mode "ON"

3.  Indents
First Line - defines the left indent of the first line in paragraph.
From Left - defines the left indent of all paragraph lines.
From Right - defines the right indent of all paragraph lines.

4. Spacing
In the Spacing section you can set the distance between the lines of text. The distance is specified in
points (though you can use other units of measure too). A positive value increases the distance, a
negative value - decreases the distance.
Character - specifies by how much to increase or decrease the distance between characters (in points).
Enter 0 for normal spacing, a positive number - to increase spacing, a negative number - to decrease
spacing.
Line - changes the distance between the lines for all selected paragraphs. When you set the value in
percent (120%,150%, etc) the spacing will be based on the font size. Also, you can set a fixed value in
points. The default value is 100%.
Before paragraph - changes the spacing between the current and the previous paragraphs.
After paragraph - changes the spacing between the current and the next paragraphs.
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5. Margins
Top - defines the top margin.
Right - defines the right margin.
Bottom - defines the bottom margin.
Left - defines the left margin.

In the picture above: 1 - Left margin, 2 - indent From Left, 3 - First Line indent.

6. Tab settings
Tab settings section allows to modify the tab position, selected in the Tab stops table.
Tab stops - specifies the default tab position for the entire shape. By default, it's 1/2 inch.
The Alignment section specifies how text is aligned with respect to the tab position:
Left - places the left edge of the text in the specified position,
Center - places the center of the text in the specified position,
Right - places the right edge of the text in the specified position,
Decimal(.) - if there's the point separator (.) in the text, the text is aligned by the point.
Comma(,) - if there's the comma separator (,) in the text, the text is aligned by the comma.

Tab stop positions are shown with red lines.

Add  - adds to the Tabs list the tab stop described in Tab Stop Position. For convenience, after you
click the Add button, the setting in the Tab Stop Position area is increased by the value of Default Tab

Stop. Remove - removes the tab stop position selected in the list.
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Hypernote

Use this control panel to assign text notes and  hyperlinks. You can add hyperlinks to any ConceptDraw
DIAGRAM object. The hyperlinks can link to another page or object in the current document, or a Web

site. Access the Hypernote inspector from the  button on the toolbar,  use the  Inspectors menu,

or context menu of the object.

Use Hypernote inspector to assign multiple hyperlinks to shapes.
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Title - Click to enter the Title of Hypernote
Hypernote - Click to enter text comments to Hypernote.
Add Link - Click to add a hyperlink using the Set Hyperlink dialog.

Hyperlinks  can be of the following types: a hyperlink to an URL to a page or an object in the current
document.
Link to Web
You can add one or more hyperlinks  to an Internet address. When such link is opened, the program
launches the default browser and goes to that address. You can type the hyperlink address manually, or
and copy and paste the link from the Internet browser.
Link to file
Allows adding hyperlink to any file on your computer, or another computer accessible via LAN and WAN.
Link to this document 
Allows adding hyperlink to another page or shape in the current document,
Go to Link 
Enables to open  the hyperlink without closing the dialog.



Dialogs

ConceptDraw DIAGRAM   User Interface Reference © 2024 CS Odessa corp.

103

Side Panels Info

Info

Thecontrol panel displays basic information about the selected shape (if there's more than one shape
selected - the information for primary selected shape). If there's no selected shape, the controls in the

inspector are disabled. You can activate Info inspector  by clicking the  button on the toolbar or using
the  Inspectors menu.

· Meta Data
Contains meta data related to an object: name, description including name of the parent library and
keywords that will help to search this object. 
· Developer Info
Contains:  ID - the unique identification number of the object within current document;
Sub ID - the unique identification number of the object within current group;
Layer - number of Layer where object is located.
ID - indicates the unique number of the shape in the current document.
Sub ID - indicates the number of the shape in its parent group. It's used for referring to shapes inside a
group.
Layer - assigns the shape to a layer. Unlike other fields of the dialog, changing layer applies to all
selected shapes, not only to the primary one.
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Custom Properties

Custom Properties panel is included to the Info group of control panels. Activate it using  button on
the main toolbar, or the Inspectors menu.
It is is used to create, modify and delete custom properties of a shape. If there are several selected
shapes, the properties will be shown for the shape with primary selection (the one that displays green
handles). 

If the shape has no custom properties, you'll be offered to Define Custom Properties. Using this

section you can assign some properties to the shape. 
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Label - the name of the property. It's used when the property is referenced to in formulas or ConceptDraw
Basic scripts.
Type - the type of the property, can have one of the following values:

String
Number
Fixed List
Variable List
Boolean

Note: When entering values of the Fixed List, Variable List or Boolean types you're offered to choose one
from the list. Also information about types can be used by CD Basic.

Format - contains the list of possible values for the properties that have the Fixed List or Variable List
types. The values are delimited by semicolon ";". For values of other types this parameter is ignored.
Value - indicates the default value,
Prompt - the text of the tip,
Verify - if enabled, checks if the property has a value, and if it hasn't, the user will be asked to provide
one,
Invisible - specifies whether to show this property.  
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Advanced

Advanced panel is included to the Info group of control panels. Activate it using  button on the main
toolbar, or the Inspectors menu. Edit object behavior, protection, and double-click properties.

· Lock
Define parameters of an object that should be locked from changes. If the selected object has some
parameters locked, its selection handle will be marked with locks.
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· Behavior on Double Click
Define Double-Click actions:
No action - No actions on Double-Click;
Edit  text - Edit a text of an Object;
Power Edit Table- Edit Shape Parameter Table;
Go to Hyperlink  - Open hyperlink;
Action - Choose one actions, assigned to object. The assigned action will be performed continuously
with Double-Click.
· Miscellaneous 
2D Shape - The selected object is assigned as two-dimensional. You can resize it by changing its height
and width;
Connector - The selected object is assigned as one-dimensional. You can resize it by changin its height
only. It can be connected to another with connecting points (the same as connector);
Scale with Group - All objects scale similarly and simultaneously around group center;
Reposition only - Group resizing will move grouped objects without resizing;
Inherit Group Settings - Apply the entire group settings while  resizing individual objects from this group;
Save Original Scale - if this option is on, the shape will keep its size when inserted into a document with
some other scale. Otherwise, the size of the shape will be changed according to the scale settings of
that document;
Shape Handles - Show/Hide handles of selected objects;
Control Handles - Show/Hide control handles of selected objects;
Alignment box - Show/Hide alignment frame around selected objects;
Hide in Presentation - Allows not to display selected objects in Presentation mode ;
Group text - Enable/Disable object text editing in group;
Select group only - Enable/Disable selecting individual objects within a group;
Select Group first - The first click on the object that is included in a group will select the entire group, the
next click will select this object within the group;
Select Child First  - The first click on the object that is included in a group will select this object within
the group, the next click will select the entire group.
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Side Panels Present

Present

Use Presentation inspector to operate  ConceptDraw DIAGRAM dynamic presentations. You can

activate Present inspector  by clicking the  button on the toolbar or using the  Inspectors menu.

 
· Slideshow
Operate slideshow using these command buttons.
You can play a slide presentation of the current document Slides will be created from document's pages.
Hover the mouse over the bottom of the screen to access the presentation control panel.
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Side Panels Present

 
 Options

Set the consecutive order of Slide Show.
Change document size to fit monitor resolution.
When the Presentation panel is active, the slide frame is highlighted in green. Thus, you can see how
the size of a real page fits the dimensions of the monitor that you select for the presentation. You can
change the size of the presentation slide so that it matches the dimensions of the presentation monitor.
ConceptDraw DIAGRAM supports multi-monitor usage. The only limit is that ConceptDraw DIAGRAM
can run only one presentation at a time. So, you can run a presentation in one monitor and have the
same or a different document open for editing on the second monitor. By default every presentation is
displayed on the primary monitor.To run a presentation on the secondary monitor select the monitor from
 Output Device drop-down list.
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Keyboard Shortcuts

Keyboard / Mouse Operation

DOCUMENT AND WINDOWS

Cmd + N Create a New Document

Cmd + Opt + N Create a new document from a template

Cmd + O Open a Document

Cmd + S Save the active document

Cmd + Shift + S Save the document under a new filename

Cmd + Opt + P Start Presentation

Cmd + P Print the active document

Cmd + Shift + P Page Setup

Cmd + Opt + G Switch Grid on

Cmd + Opt + R Show Page breaks

Cmd + Opt + W Close all active windows

Cmd + W Close the active window

Cmd + M Minimize the active window

Cmd +<window
number>

Activate the certain window

F6 Open Shape Parameter Table

VIEW

Cmd + "=" Zoom In

Cmd + "-" Zoom Out
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Cmd + Opt + Z Activate the Zoom Box mode

Click/ Click + Opt in
Zoom Box

Zoom In/ Zoom Out

Cmd + 0 Set zoom to Whole Page

PgUp Scroll one window space up

PgDn Scroll one window space down

Cmd + Home Go to the top-left corner of the page

Cmd + End Go to the bottom-left corner of the page

Cmd + PgUp Go to the previous page

Cmd + PgDn Go to the next page

SELECTING SHAPES

Select with Shift Allows to select several shapes

Cmd + A Select all the shapes on page

Ctrl + T Activate Text Selection Tool

Tab/ Shift + Tab Select the next/ previous shape

Shift Select objects without quitting the mode

Keyboard / Mouse Operation

HYPERLINKS

Ctrl + Shift + E Create / Edit hyperlink

Ctrl + Shift + H Open hyperlink

EDITING

Cmd + Z Undo the last operation
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Cmd + Shift + Z Redo what was reversed by Undo

Cmd + X Cut the selection to the Clipboard

Cmd + C Copy the selection to the Clipboard

Cmd + V Paste the content from the Clipboard

Cmd + F Find

Cmd + Shift + G Find next

Cmd + Shift:+ ; Spelling

Del / Delete Delete the selected shape(s)

Cmd + D, Duplicate the selected object(s)

Insert Vertex with Cmd Cut the line in this place

LIBRARIES

Cmd + Shift + N Create a new library

Cmd + Shift + O Open a library

Cmd + Shift + I Replace the library object with page object

F4 Show/Hide Library Window

SHAPES

Cmd + Opt + B Send to Back

Cmd + Opt + F Bring to Front

Cmd + Shift + B Send Backward

Cmd + Shift + F Bring Forward

Cmd + Shift + J Flip Vertical
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Cmd + Shift+ H Flip Horizontal

Cmd + L Rotate Left (90 degrees)

Cmd + R Rotate Right (90 degrees)

Cmd + Left/Right Rotate by 1 degree

Cmd + Shift + Arrow Rotate by 0.1 degree

Resize with Shift Toggle between unproportional and proportional resizing

Keyboard / Mouse Operation

Arrows/ Shift + Arrows Move the selection

Cmd + G Group the selected shapes

Cmd + U Ungroup the selected shapes

DRAWING MODES

Ctrl + 1 Activate Select tool

Ctrl + 2 Activate Text tool

Ctrl + 3 Activate Line tool

Ctrl + 4 Activate Sector tool

Ctrl + 5 Activate Arc tool

Ctrl + 6 Activate Spline tool

Ctrl + 7 Activate Rectangle tool

Ctrl + 8 Activate Ellipse tool

Ctrl + 9 Activate Connector tool

Ctrl + 0 Activate Eye Dropper tool
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F5 Activate the Text Editing mode

Shift in drawing Constrained drawing (circle, square, etc.)

Cmd + Shift + R Activate Rapid Draw mode

TEXT FORMATTING

Cmd + B Bold for selected text

Cmd + I Italic for selected text

Alt+Cmd + U Underline for selected text

Cmd + L Align on the left for selected text

Cmd + E Align in the center for selected text

Cmd + R Align on the right for selected text

Cmd + “.” Increase font

Cmd + “,” Decrease font

Esc Finish editing

APPLICATION

Cmd + “?” Open ConceptDraw Help

Cmd + ";" Preferences (Application Settings)

Cmd + Opt + H Hide ConceptDraw

Cmd + Q Quit ConceptDraw


